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1. Pre-Installation 

A. Esteem Licensing 

 NETWORK DONGLE 
LICENSE 

STANDALONE 
DONGLE LICENSE 

CLOUD LICENSE 

LICENSE 
SERVER 
REQUIREMENT 

User-hosted server on 
network. 

None None 

ACCESSIBILITY License available within 
network 

License only available 
on client machine 
where it is currently 
activated 

License available via 
internet 

INTERNET 
REQUIREMENTS 

• Internet access required on 
server to activate license. 
• Network access/vpn required 
between server and client 
machines. 

Internet access 
required to 
activate/deactivate 
license on client 
machine. 

Internet access required 
to access the license. 
Client machines can 
continue to access 
license up to 4 hours 
offline.  

LICENSE 
MANAGEMENT 

License managed by external 
utilities on server 

License managed by 
external utility on client 
machine. 

License managed by 
external utility on third-
party server 

Installation 
Prerequisites 
Required 

• Esteem Network Manager 

• Senselock driver for 64 bit 

• Microsoft .Net Framework 
4.7+ 

• Visual C++ 2022 
Redistributable x64 

• VectorDraw FileConvertor 
4.0 

• Senselock driver for 
64 bit 

• Microsoft .Net 
Framework 4.7+ 

• Visual C++ 2022 
Redistributable x64 

• VectorDraw 
FileConvertor 4.0 

• Senselock driver for 
64 bit 

• Microsoft .Net 
Framework 4.7+ 

• Visual C++ 2022 
Redistributable x64 

• VectorDraw 
FileConvertor 4.0 

Uninstallation 
Applications 

Esteem User License Utility Esteem User License 
Utility 

None 

Check out our website: 
https://www.esteemsoft.com 

Check out our Youtube Video(s): 
Esteem 11 Software in 25 minutes | Increased Performance | Increased Productivity | Increased Profit 

https://www.esteemsoft.com/
https://www.youtube.com/watch?v=5jEO7iopiXk
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B. System Requirements 

The following system requirements must be satisfied for the Esteem 11 installation to be successful 

Operating 
System 

Microsoft Windows 7 SP 1 (64-bit only) 
 Windows 8 (64-bit only) 
 Windows 10 (64-bit only) 
Windows 11 (64-bit only) 
 
Note: Windows 11 (64-bit) must be stable official release  
(cannot be Windows 11 Insider Preview Build) 

Processor Basic: Intel Core TM i5 or equivalent 2.5 GHz processor 
Recommended: Intel Core TM i7 or equivalent 3.2+ GHz processor 

Memory / RAM Basic: 8GB 
Recommended: 32 GB or more 

Graphics / 
Display card 

Basic: NVIDIA GeForce 210 or equivalent 512 MB memory graphic 
card with Open GL  4 support 
Recommended: NVIDIA GeForce GTX1050 or equivalent 2GB 
memory graphic card with Open GL 4 support 
 
Note: Graphics cards may include integrated graphics card, 

Disk Space Basic: 3 GB 
Recommended: Recommended: 10% to 20% Free Disk Space 

.Net   Framework .NET Framework Version 4.7 or later 

Administrator Permission 
You need administrative permissions to install. To verify in Windows, select Control Panel > User 
Accounts. Another option is that on your Windows non-admin accounts: you run your installer as 

administrator . 

Install system updates and temporarily disable antivirus programs. 
If your computer(s) have pending operating system updates, install them and restart. Consider 
temporarily disabling antivirus programs, because they might interfere with installation process. If 
prompted by your antivirus program, please allow Esteem 11 installation to proceed. 

C. Download Esteem 11 Installation Folder 

Download the Esteem 11 installation folder by following the instruction(s) which could usually be found in 
your company/preferred mail inbox or on your account at Esteem Download Center. For your account 
login details, please WhatsApp us at +603-8076 2788 or email us at support7@esteemsoft.com.my 

 
Figure: Esteem 11.x.x.x email example 

https://download.esteemsoft.com/
https://wa.me/60380762788
mailto:support7@esteemsoft.com.my?subject=RE:%20Esteem%20Account%20Login%20Details
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Or use your account at Esteem Download Center to download your Esteem Installations and other 
Installation Prerequisites 
Note:  

a) access to your account at Esteem Download Center are valid during your Esteem license software 
maintenance or subscription period.   

b) please use Microsoft Edge or Google Chrome browser for the downloads. 
c) To manage your Esteem related installation folder(s), please refer to this link. 

  

If you are installing Esteem Network license(s), please also download the Esteem Network Manager 
from the Esteem Download Center.  
Note: this is not required for standalone dongle and cloud subscription license(s). Esteem Network 
Manager is necessary for Esteem Network license(s), because would need to install  

 

https://download.esteemsoft.com/
https://download.esteemsoft.com/
https://download.esteemsoft.com/
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2. Installation 

Installation for either Network Dongle License, Standalone Dongle License, Cloud License. 

A. Network Installation Instructions 

Please skip this step(s) using this link, if you are not installing network dongle license(s). 

This instruction consists of two parts. Installation for: 
1. Server's PC and 
2. Client's PC 

i. Server's (Main) PC 
1. Install the senselock driver: 

the senselock driver for 64-bit machine is located in the Prerequisites folder or your can 
download it from our Esteem Download Center. 

 
2. Plug in the network dongle into the server. 
3. Copy the 'Esteem 9 Software Network Manager' folder into the server's computer 

Note: It is recommended to copy your 'Esteem 9 Software Network Manager' folder to 
C:\Program Files or any other secure folder location(s) to avoid accidental deletion. Avoid placing 
the folder in temporary or user-specific locations (like the Desktop or Downloads folder) 

 
4. Inside this folder, double-click 'inst.bat'  to install the network manager 
5. Next, double-click the 'e4nmgr.exe' application to run the network manager 
6. The 'Select EL Net Service' window will pop up. Select the network dongle 'EliteIV Net Service 

(este)' from the list and click OK. 

https://download.esteemsoft.com/
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7. Right-click on the '127.0.0.1(Localhost, service is not activated)' and select 'Start Service' or click 

on the start icon  to start the network service 

. 

8. To connect the network service with the network dongle, right-click on the item again and select 
'Connect'. 

9. The network dongle is now connected with the number of licenses shown. 

 
ii. Client (User's PC) 

1.  At client's PC, right-click on the Esteem shotcut icon and select 'Open File Location' 

 

This will lead you to the installation folder. Right-click on file 'E4ncli.ini' and select Edit. Make changes to 
the HOSTADDR value depending on whether your user’s pc is connected the server’s computer network 
via either ethernet or wireless 

Ethernet: make sure it is “localhost” (without 
the quotation marks) 

Wireless: enter the ip address of the server (as 
per red highlighted) and then save the file 
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Make changes to your client computer configuration setting to connect your user’s pc to the network of 
the server PC. Then you can install the Esteem application on your computer. 
 
Note: the previous step(s) is only required if you are only installing Esteem network license(s). This is not 
applicable to standalone dongle and cloud subscription license(s). 

B. Esteem Installation on Windows 

Applicable for Network dongle license, Standalone dongle, and cloud subscription.  
Note: for Network dongle license – must also install a Esteem Network Manager application on the 
Server’s (Main) PC, please refer to this link for further instructions. 

Using the downloaded Esteem 11 installation folder. Double click on the installer “Esteem 11.x.x.x 

Setup.exe”      to start the installation wizard on the computer(s). 

 
Figure: Esteem 11.x.x.x Installation Folder 

If prompted by your antivirus program e.g. Microsoft Defender Antivirus, please allow Esteem 11 
installation to proceed. 
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C. Prerequisite Dialog box 

 

Figure: Prerequisite Setup 

Pop-up message, will appear if the Esteem installer program detect Esteem prerequisite(s) are missing 
from your computer.  

 

Prerequisites List 

• Senselock driver for 64 bit 

• Microsoft .Net Framework 4.7+ 

• Visual C++ 2012 Redistributable x64 

• VectorDraw FileConvertor 4.0 

If the prerequisites have been detected as installed on your computer, then this pop-up message will not 
appear. 

Note: this pop-message could be false negative, i.e. the prerequisites have been installed on your 
computer, but the Esteem installer program detect wrongly. Another possibility is that it is positive 
negative, i.e. the prerequisites have not been installed on your computer, therefore the Esteem installer 
program detect correctly 
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Tick the uninstalled prerequisite 
Note: The Esteem installer program runs checks for the software prerequisites, and if any prerequisites 
are missing, it lists those missing prerequisites and requests that they be installed. 

 
Figure: e.g. Esteem Prerequisite Dialog box (Tick uninstalled prerequisite) 

You could also install the Esteem prerequisites through the ‘Prerequisite Installers’ enclosed in your 
Esteem 11 Installation Folder. Please email support7@esteemsoft.com.my, if you could not find it in your 
accompanying Esteem 11 installation folder,  
(Note: Enclosed in the Prerequisite Installers there are the following prerequisites (as per green 

highlighted in the attached below     ; some of these prerequisites can also be installed through online 

sources e.g. .Net Framework and Visual Studio C++ Redistributable (x64) 
 

Figure: 

Prerequisite Installers Folder

 

 

mailto:support7@esteemsoft.com.my?subject=Request%20for%20Esteem%20Installer
https://dotnet.microsoft.com/en-us/download/dotnet-framework
https://www.microsoft.com/en-us/download/details.aspx?id=30679
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i. If False Negative (Prerequisite Pop-up Message) 
If this pop-up message appeared asking about ‘Repair’ or ‘Remove’ then click cancel as green 

highlighted and then click Close (as per green highlighted on the attached below     ) 

Note: if the dialog box pop up asking you whether to repair or remove [prerequisite], it means that the 
prerequisite has been installed on your computer.  

 
 

Figure: E.g. Repair or Remove Esteem [prerequisite] dialog box. 
Note: the [prerequisite] might be different than what is shown. This depend on the Esteem [prerequisite] 
that is detected as missing from your computer. 
 
Additional Note: 

    You can double check whether the prerequisite(s) has been installed by window searching Esteem 

[prerequisite] on your computer. 

 
Figure: Windows search of the Esteem [prerequisite] 
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After confirming that the Esteem prerequisite(s) has been installed on your computer, on your 
prerequisite dialog box continue with the prerequisite(s) unticked. 

 
Figure: Esteem Prerequisite Dialog box (don’t tick uninstalled prerequisite) 

ii. If True Negative (Prerequisite Pop-up Message) 
Continue with the Esteem prerequisite installation 
 
e.g. Installing Visual C++ 2022 Redistributable (x64)…., which is one of Esteem [prerequisite] as shown 
after agreeing to its EULA (end-user license agreement) 
Note: the [prerequisite] installation could be different than what is shown, depending on what 
[prerequisite] are detected as missing by the Esteem installer program 
 

 
 

Figure: Visual C++ 2022 Redistributable (x64) … Installation Bar Progress and its ‘Setup Successful’ 
dialog box. 
 
Please restart the computer if prompted to after the prerequisite successful installation/setup and then 
continue with the Esteem 11 installation after computer restart. 
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D. Welcome to Esteem 11.x.x.x Setup 

After the Esteem prerequisites have been detected as being installed on your computer, you might have 
the option to choose either to remove existing Esteem version or keep existing Esteem version when 
installing the newer Esteem software version 
Note: this option is available if there are existing Esteem version(s) on your computer; your computer(s) 
need at least 3GB of hard disk to install Esteem 11 software. However, it is recommended to have at 
least 10% to 20% Free Space on your selected Disk. 
 
After making your choice, click ‘Next’ to continue with the installation 

 
Figure: Dialog Box to remove existing Esteem version(s) or to install side by side with other [Esteem] 
versions  
 
Click ‘Next’ to proceed with the Esteem setup  
(make sure that your computer is connected to the internet) 

 
Figure: Dialog Box_Welcome to Esteem 11.x.x.x Setup 
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End-user License Agreement 
Review the Esteem End-User License Agreement, if you agree with using terms and conditions of 
Esteem software, please click ‘Next’ and then click ‘I Agree’ to proceed with the installation. 

 

 

Figure: Dialog box for Esteem EULA (End-User License Agreement) 
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E. Esteem 11 Activation 

Esteem License 11 Activation for either standalone dongle perpetual license(s) or Esteem cloud 
subscription license(s) 

i. Esteem standalone/network dongle perpetual license(s) 
Note:  
a) If you are also licensed Esteem cloud subscription license(s), you must also use your 

designated Installer Serial Username & Serial Key to use your Esteem cloud subscription 
license(s) 

b) For Esteem network manager server installation, please refer to this link. For Esteem installation 
and activation on the client computer, please refer to this guide. 

Note: your username and serial key could also be found in your mail inbox or on your account at Esteem 
Download Center 

  
 
if you could not find it please WhatsApp us at +603-8076 2788 or email at support7@esteemsoft.com.my 
 
At the following installer ‘Dongle Cloud License Option’ page 
 
After choosing Dongle on the installer ‘Dongle Cloud License Option’ page, enter your username and 

serial key in the respective textboxes.     and then click ‘Next’ 

 

 
Figure: Username and Serial Key textbox  
Internet connection is required for Esteem 11 activation. 

https://esteemsoft.com.my/images/document/14821881/Manual_EsteemSoftware_NetworkManagerInstallationandUninstallation.pdf
https://download.esteemsoft.com/
https://download.esteemsoft.com/
https://wa.me/60380762788
mailto:support7@esteemsoft.com.my
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ii. Esteem cloud subscription license(s) 
Note: If you are only licensed Esteem cloud subscription license(s), you must use your designated Email 
& Password for your Esteem cloud subscription license(s) activation. If you could not find your cloud 
license login details, please WhatsApp us at +603-8076 2788 or email at support7@esteemsoft.com.my 
 
After choosing Cloud on the installer ‘Dongle Cloud License Option’ page, enter your Email and 

Password in the respective textboxes.     and then click ‘Next’ 

 

    choose the Install location on the Destination Folder for your Esteem 11.x.x.x software then click 

‘Install’ 

(Note: 3GB disk space is required to install the Esteem 11 software; confidential or irrelevant 
information has been greyed out) 

 
Figure: Esteem Installation Folder dialog box 

https://wa.me/60380762788
mailto:support7@esteemsoft.com.my
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Wait for the Esteem 11.x.x.x software installation process to be completed . 
(Note: the installation process might take a few minutes) 

 
Figure: Esteem 11 Installation Bar Progress 
 
 
Click ‘Finish’ after the Esteem 11.x.x.x Installation Progress has been completed 

 
Figure: Esteem 11.x.x.x Installation Complete Dialog Box 
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Your Esteem 11.x.x.x is now ready to be used. 
Note: when running Esteem 11 software please ensure that your Esteem 11 or higher dongle version is 
attached to your computer. 

 
Figure: e.g. Esteem 11.x.x.x pop-up: 
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F. Troubleshooting 

If you encounter the following issue/errors during installation, please try to follow the steps below to 
resolve it. 

 

i. "Could not validate serial" error message at ‘User License Activation’ stage in installation 
wizard. 

Solution: In Internet Properties please make sure ‘Use TLS 1.2’ is turned on as shown: 

 
ii. “This setup requires the .NET Framework version 3.5” in the “VectorDraw FileConverter 4 

Evaluation” popup dialog: 

 
Solution: In Windows Features, please make sure the following feature ‘.NET Framework 3.5 (includes 
.NET 2.0 and 3.0) is turned on as shown: 

 



 
 

20 | P a g e  

iii. “Failed to install Senselock Elite series device driver. Failure Not enough system 
resources…” 

 
 
[Note: this issue has been resolved in the latest senselock driver, accessible exclusively for Esteem 
license(s) whose software maintenance are subscribed to as of January 2024 or later] 

 
Solution: Go to the Core isolation page by searching for "Core isolation" in windows search. Make sure 

memory integrity is turn off in Core isolation. Restart the computer if it was previously on and it 
is turn off now. 
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iv. Windows Installer Error “Another program is being installed…” 

 
Reason: 

Here are the known issues as per listed below      

1. Background Installations: Windows may be silently installing updates or other software in the 
background, occupying the Installer service 

 

Solution: 

Resolve by doing the following: on your Windows Task Manager: select the application “Esteem Installer 
(32 bit)” under the Background Process, and then click “End task”. If the error persists or the “Esteem 
Installer” is not in the Background Process, try to “End Task” of other Installer application(s) that might be 
in the Background Process. 

 
 



 
 

22 | P a g e  

v. Lock Not Found! The program will now exist! 

 
Reason: 

Here are the known issues per listed below     : 

1. The dongle is not attached properly. This is shown when you cannot find “Elite4 2.x” or “Senselock 
EliteIV v2.x” in your device manager (in your device manager it could be found either under  “Other 
Devices”, “UniversalSerial Bus Controllers”  or “Smart card readers”) 

Solution: 

Check that the the dongle is attached to an USB port. If already attached, please try the dongle on 
different USB port. After attaching, please check that your dongle is detected in the device 
manager.  
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2. Dongle driver detected, but is not properly installed  
Note: check in your device manager the dongle driver that is not properly installed. It would be 

detected as per attached below with the warning sign      on your Device Manager probably under 

“Other Devices”, because it typically lists hardware components that Windows cannot 
automatically identify or doesn't have the appropriate drivers for. However, if it is not there, then it 
is under either “UniversalSerial Bus Controllers”  or “Smart card readers”. 

 
Solution: 

Unplug and plug the dongle to another usb port. If this challenge persists. Reinstall the latest 
dongle driver and check that either Elite4 2.x” or “Senselock EliteIV v2.x” does not have warning 
sign next to it. 

 
Download the latest Esteem Dongle Driver using  Esteem Download Center and then install it. 

 

https://download.esteemsoft.com/
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3. Current user account does not have administrator rights 

Solution: 

Use current account user that has administrator rights 

If you are already logged in as an administrator: 

• Access Settings: Open the Windows Settings app. 

• Navigate to Accounts: Go to "Accounts" and then "Family & other users". 

• Select User: Choose the user account you want to modify. 

• Change Account Type: Select "Change account type" and then choose "Administrator" from the 
dropdown menu. 

• Confirm: Click "OK" to save the changes.  

If you are not logged in as administrator 

Option 1: Enable the built-in Administrator account: 

• Open Command Prompt as Administrator: Search for "cmd", right-click, and select "Run as 
administrator".  

• Enable the account: Type net user administrator /active:yes and press Enter.  

• Restart your computer: You should now see the built-in administrator account listed at the login 
screen.  

• Log in as Administrator: Log in using the built-in administrator account.  

• Modify user account: Follow the steps above to change the desired user account to administrator.  

• Disable built-in account: After modifying the user account, it is recommended to disable the built-in 
administrator account again for security reasons using net user administrator /active:no.  

Option 2: Use another administrator account: 

•  Log in with another administrator account: 
If you have access to another administrator account, log in with that account. 

• Modify user account: 
Follow the steps above to change the desired user account to administrator.  

If you are still encountering challenge(s) after following the recommended step to take, please email 
support7@esteemsoft.com.my for assistance. In that message, please share your name, company 

name, and a brief description of the challenge(s). 

mailto:support7@esteemsoft.com.my
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3. Uninstallation 

Use the Windows control panel to uninstall Esteem software. If you are only using Esteem 11 
standalone/network dongle, you would also need to deactivate the uninstalled Esteem software using 

Esteem User License Utility 11.0.0.0.exe . Deactivation is not 
required if you are only using Esteem cloud license(s) 

• Sometimes, remnants of a previous installation remain on your system after you remove software 
through the Windows control panel. You must remove them before you can install new versions. In 
these cases, use the Microsoft Installation Troubleshooter, previously called Fix It, to remove the 
remnants.  
 

A. Using Windows Control Panel to uninstall 

1. Open Control Panel (On the search bar use keyword e.g. uninstall or program > click either 
uninstall a program or Change or remove a program). 

 
2. Select the Esteem Software version you want to uninstall (on the search bar use keyword e.g. 

esteem > right click the Esteem version you want to uninstall) 

 

3. Click Uninstall  
4. Confirm and click Finish 

 
5. Restart if prompted. 
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B. Deactivation 

Important Note: Esteem 11 Deactivation is only valid if you also using Esteem 11 
standalone/network dongle license(s). Please skip this step(s), if you are only licensed Esteem 
cloud license(s). 

Use Esteem User License Utility 11.0.0.0.exe  to deactivate and/or 
reactivate your Esteem 11 installation(s) on your Windows computer. 
 
Note: 
Download Esteem User License Utility 11.0.0.0.exe from Esteem Download Center 

 
 
Steps to use the Esteem 11 User License Utility App:  
 

1. Double click on 'Esteem User License Utility 11.0.0.0.exe'  
2. Enter your username and serial key. 
Note: username and serial key could be found in Esteem Download Center under Software Downloads 
group. 

 

3. Click the 'Deactivate' button  to deactivate any existing Esteem 11 and above 
versions from your computer(s). 
 
Note: Deactivating all your Esteem 11 application(s) from your computer, would release the Esteem 11 
application(s) to be available for installation on your other computer(s).

https://download.esteemsoft.com/
https://download.esteemsoft.com/
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C. Reactivation 

Important Note: Esteem 11 Reactivation is only valid if you also using Esteem 11 
standalone/network dongle license(s) and your computer hostname has changed. Please skip 
this step(s), if you are only licensed Esteem cloud license(s). 

Use Esteem User License Utility 11.0.0.0.exe  to deactivate and/or 
reactivate your Esteem 11 installation(s) on your Windows computer. 
Steps to use the Esteem 11 User License Utility App for Reactivation: 

1. Double click on 'Esteem User License Utility 11.0.0.0.exe ' 

2. Click the 'Reactivate' button  to get a new license if hostname changes for 
your active machine, to resolve 'This machine is not licensed to run this software' error message 
on Esteem 11 startup 

3. If the error ‘Could not find existing active machine’ appears when click ‘Reactivate’ 

 
2. Please provide your Computer name and also your Windows UUID for us to check on our side: 
3. On your windows computer, open Command Prompt and enter the following commands to get 

your Computer name and also your Windows UUID. 
Note: to open command prompt please refer to the following article: 

Enter the command to get your computer name:  
hostname 

 
Enter the command to get your Windows uuid command:  
wmic csproduct get UUID 

 
 

https://www.lifewire.com/how-to-open-command-prompt-2618089#:~:text=This%20article%20explains%20how%20to%20open%20Command%20Prompt%2C,8%2C%20Windows%207%2C%20Windows%20Vista%2C%20and%20Windows%20XP.
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D. Esteem Network Manager Uninstallation 

Important Note: Only applicable for Server's (Main) PC uninstallation, to uninstall Esteem application on 
the Client (User's PC), please refer to this link. 

1. Stop network service running the Esteem Network Manager 

2. Open local services, and find EliteIV Net Service (este) 

3. If its Status displays “Running”, right click on it to open a dropdown box and click “Stop” as 
shown. 

 
4. Then Run “uninst.bat”  

a. Go to Network Manager Directory. 
b. Double click on uninst.bat shown below 
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4. Manage your Software 

View your Esteem Software License Information 

You can monitor current license information for each of your Esteem Integrated Software Package on 
your Esteem application. 

Find license information on your Esteem application (as per red highlighted in Picture Two and 
Picture Three) 
e.g. To access this information (on your Esteem toolbar go to Help > Hardlock Properties or go to 
Help > About Esteem 11 as per blue highlighted in Picture One) 

 

[2. Picture Two] 
Go to Help > Hardlock Properties 
(This Option can copy and paste) 

[3. Picture Three] 
Go to Help > About Esteem 11 
(This Option is unable to copy and paste) 
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A. Esteem Download Center 

Use Esteem Download Center to download the latest Esteem Integrated Total Solution Software(s), 
Esteem Installation Prerequisites, and Esteem User License Utility 

View Release notes, and Installation & serial key. 

Have not registered for Esteem Download Center? Please WhatsApp us at +603-8076 2788 or email 
support7@esteemsoft.com.my. 

Note: access to your account at Esteem Download Center are valid during your Esteem license 
software maintenance or subscription period.  

To unzip the file, please refer to this link. 

Esteem Integrated Total Solution Software(s) 

Description License Type Screenshot 

Esteem 
Integrated 
Total Solution 
Software 

Standalone 
Dongle, Network 
Dongle, Cloud 
Subscription 

 

Esteem Installation Prerequisites 

Description License Type Screenshot 

Dongle 
Driver;  

Standalone Dongle, 
Network Dongle 

 

VectorDraw 
File 
Converter 

Standalone Dongle, 
Network Dongle, 
Cloud Subscription 

Esteem 
Network 
Manager 

Network Dongle 

https://download.esteemsoft.com/
https://download.esteemsoft.com/
https://wa.me/60380762788
mailto:support7@esteemsoft.com.my
https://download.esteemsoft.com/
https://support.microsoft.com/en-us/windows/zip-and-unzip-files-8d28fa72-f2f9-712f-67df-f80cf89fd4e5
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License Utilities 

Description License Type Screenshot 

Esteem User 
License 
Utility 

Standalone Dongle, 
Network Dongle 
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B. Esteem Online Resources Center 

Use Esteem Online Resources Center to download the latest Esteem Revit Add-in Installers. 

Have not registered for Esteem Online Resources Center? Please WhatsApp us at +603-8076 2788 
or email support7@esteemsoft.com.my. 

Note: access to your account at Esteem Online Resources Center are valid during your Esteem 
license software maintenance or subscription period.  

 
Important Note: Make sure to have Revit installed, before installing the Esteem Revit Add-In . You will 
need to install the Esteem Revit Add-In Version which correspond to your Revit Version. 

 

Note: 

Esteem Innovation is an Autodesk authorized developer. Please refer to this link for further 
information

https://resources.esteemsoft.com/
https://resources.esteemsoft.com/
https://wa.me/60380762788
mailto:support7@esteemsoft.com.my
https://resources.esteemsoft.com/
https://apps.autodesk.com/en/Publisher/PublisherHomepage?ID=201003110106555
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5. FAQ 
Post-Installation 
2. When I double-click on Esteem application, the program is not launched. 

The dongle might not be detected on the current USB port. Unplug the dongle and try on another 
USB port 

3. When I click on an Esteem application, an error message pops up saying that "hard lock 
cannot be found" 
First, check whether your dongle is attached to your pc/computer, if not, then attached the correct 
dongle. 
 
If the problem persists, then perhaps your dongle is not connected properly to your USB port. Try 
reconnecting it again. 

4. When I click on an Esteem application, an error message “Class not registered “appears  

 
This challenge is due one of the application components not properly registered. During installation: 
all components must be installed and properly registered. Sometimes, some components are not 
properly installed, thus causing this error message to appear. 
 
Solve this challenge by first restarting your computer and click on the Esteem application again. If 
this challenge persists, then it is likely that the vdpro.ocx is at fault. Thus, manually register class by  

• On your Windows search bar type “run” (without the quotation marks) then type egsvr32 <path 
to vdpro.ocx>.  
E.g. regsvr32 "C:\Program Files\VectorDraw\Components\1039\Ansi\vdpro.ocx" 
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5. What is the error message stating that the dongle is not compatible with the software? 

 

This means that the dongle is outdated already. To use the latest Esteem application, please exchange 
the older dongle with us. Contact our designated person Joshua through WhatsApp +601-10702137 or 
email joshuationg@esteemsoft.com.my  
 
6. There are two identical icons with the name “Setup,” which should I click/choose? 

Click the one which has a smaller size. Check the file size by right clicking on that file, choose 
properties->general. Look for the size. 
 

7. During installation: there are no two identical icons with the name “Setup.” There is 
“Setup” with Esteem application icon on it, and another file with the name "%AppName% 
%versionNumber% %releaseType%" with the normal Windows Installer icon on it. Which 
one should I click/choose? 
The installation icons were enhanced. To setup your Esteem application, click on “Setup”. This 
will ensure that the application and its accompanying prerequisites are properly installed. If 
"%AppName %versionNumber% %releaseType%" is clicked/chosen, the Esteem application will 
only be installed, without its accompanying prerequisites. 

8. When I start your application, a dialog box with the string "Directory doesn't exist" pop 
up. 
Sometimes when the Esteem application is clicked, a series of unexpected dialog box(s) will pop 
up in the following sequences (left to right): 

 
This is because of the dongle driver challenge. Solve this challenge by unplugging all the 
attached dongle(s) and plug back only the one that is needed for running the Esteem application 

9. How can I tell if Microsoft .NET Framework is installed on my computer? 
Installing Microsoft .NET Framework does not add an entry to your Add/Remove Programs dialog 
on your Control Panel. The only way to check if the Microsoft .NET Framework is installed is to 
check the following registry setting in the Registry Editor: 

• Key Name: Computer\HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\NET Framework 
Setup\NDP\v3.5 

• Value: SP 

• Data Type: REG_DWORD 
 

The SP value data informs you whether .NET Framework has been installed. E.g., if the SP value is 0, 
then no .NET Framework is installed. If the value is 1, then the .NET Framework is installed

https://wa.me/601110702137
mailto:joshuationg@esteemsoft.com.my


 
 

35 | P a g e  

10. My computer has a nVidia OpenGL driver error which seems unrelated. 
When you click on Esteem applications, the following message pops up 

 
Solution: you must install the latest version of nVidia driver which is used by your graphic card on your 
pc. It is unclear why such challenge(s) occurs. 

11. I installed your prerequisites successfully, however, when I tried to install Esteem 
application, an error message e.g. “prerequisites missing” still occur. How to solve this? 
The reason this error occurred may be due to the “missing” prerequisites may have been installed 
on your computer of different versions. Consequently, the windows installer may reference the 
wrong prerequisites, when it installs the Esteem application. 
 
Solution: uninstall all prerequisites’ versions and reinstall the Esteem application again. Uninstall 
the prerequities by going to Control Panel > Add/Remove Program, remove all the prerequisites 
 
Disclaimer: Please check whether other applications other the Esteem application depend on the 
different prerequisites’ versions 

12. Error HRESULT: 0xc8000222 occurred when install Microsoft .Net Framework: 
This may occur if the temporary folder of Windows Update has been corrupted. You may refer to 
the following step(s) below to solve this error: 

• Use your Windows command prompt as administrator. Please run the following command i.e. “net 
stop WuAuServ” (without the quotation marks) in the opened command prompt. 

 
• On your Windows search bar type “run” (without the quotation marks) > type: %windir% > press OK. 

 
• In the opened folder, rename the folder SoftwareDistribution to Sdold. 

• Use your Windows command prompt as administrator. Please run again the following command i.e. 
“net stop WuAuServ” (without the quotation marks) in the opened command prompt. 

• Try to install Microsoft .Net FameWork  
13. What should I do if the information needed cannot be found here? Contact us. Read Contact 

Esteem for further details. 
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6. Contact Esteem 

Esteem Innovation is the leading provider of reinforced concrete structure design solutions in Malaysia. 
Engineers, consultants, government departments, and academic institutions turn to our software for the 
latest integrated analysis, design, and detailing with costing solutions.  
 
Official website: https://www.esteemsoft.com 
Official support email: support7@esteemsoft.com.my 
Official WhatsApp: +603-8076 2788  
Office hours: Monday to Friday 8:30 AM to 5:30 PM (GMT +8) except public holidays 
 
Malaysia 
Esteem Innovation (Asia) Sdn Bhd [201201001279 (974803-A)] 
7A Jalan Kenari 10, 
Bandar Puchong Jaya, 
47100 Puchong, Selangor, Malaysia 
 
Office Tel/WhatsApp: +603-8076 2788  
Office Fax: +603-8076 2677 
 
Singapore 
Esteem Innovation Pte Ltd (200008042C) 
138 Robinson Road #02-26,  
Singapore 068906 
 
Office Tel: +65-6408 9667 
Office Fax: +65-6399 3699 
 

A. Esteem Pricing and Maintenance 

Esteem Innovation professional sales staff is ready to answer your sales questions Monday to Friday 
8:30 AM to 5:30 PM (GMT +8) except public holidays. 
Contact your sales representative to hear about the latest products, training, upgrade options and 
prices, and more. If you have technical question(s) or challenge(s), please contact Technical Support 
and we will get back to you within 24 working hours. 
 
Contacting your Esteem Sales Representative 
 
Malaysia 
Mobile/WhatsApp: +60-111-070-2137 (Joshua Tiong, Sales Executive) 
Email: joshuationg@esteemsoft.com.my 
 
Singapore 
Mobile/WhatsApp: +65 9338 8092 (Zen Tan) 
 
In your message, please include your name, company name, contact number, and a brief description of 
your enquiry, to ensure that your request is handled promptly.  

https://www.esteemsoft.com/
mailto:support7@esteemsoft.com.my
https://wa.me/60380762788
https://wa.me/60380762788
https://wa.me/601110702137
mailto:joshuationg@esteemsoft.com.my
https://wa.me/6593388092
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B. Technical Support 

On your Esteem application: online and print documentation are provided to enable you to work 
independently and for self-help. 

 

 Have technical question(s) that you cannot find the answer with our provided online resources? please 
contact our Technical Support department. 

Esteem technical support is covered under Esteem license software maintenance(s), which is renewable 
with a paid subscription/software maintenance renewal.  

Esteem Software Maintenance benefits include: 
Dedicated technical support, including remote support via Esteem TeamViewer 12. 
Esteem TeamViewer 12 can be downloaded from Esteem Download Center. 
 
(Have technical enquiries? Please email us at support7@esteemsoft.com.my or WhatsApp us at +603-
8076 2788) 
 
Software updates and upgrades to enhance the stability and performance of your Esteem software. 
 
Complimentary online training resources to help you maximize productivity with Esteem Integrated 
Total Solution Software. 
 
15-Day Emergency Cloud License: As a contingency plan, this temporary license ensures 
uninterrupted access to Esteem software in case your company encounters issues with its Esteem 
dongle(s). This allows you to maintain seamless operations while we work to resolve the issue with your 
physical dongle. When necessary, license duration will be extended based on the severity of the issue or 
unexpected delays in resolution. 

We provide technical support for the following that you might encounter      

1. Esteem installation/access and  
2. Esteem modeling, analysis, design, detailing, and costing solution

https://download.esteemsoft.com/
mailto:support7@esteemsoft.com.my
https://wa.me/60380762788
https://wa.me/60380762788
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Information to Provide 
When contacting Technical Support via phone or email, please provide the following information 

below      for the fastest possible service: 

i. Esteem Installation and Access 

• Your name, company name, and phone number 

• Esteem software version 

• Types of operating system 

• A brief description of the current challenge(s) that you are encountering 

• Exact wording of any messages displayed when you encountered the problem (a screenshot would 
be helpful) 

• Steps taken to resolve your current challenge(s)  
(Only Recommended if you have done that and to have a quicker troubleshooting) 

• Please also email us the following folder, if they can be found: 
e.g. "C:\Documents and Settings\User\Application Data\Esteem\Esteem ULOCK\Error" 
 

ii. Esteem Modeling, Analysis, Design, Detailing, and Costing Solution 

•  Company name 

• Brief description of your inquiry/issue 

• Your zipped Esteem backup file regarding your challenge/issue (without analysis/design) to 
support7@esteemsoft.com.my. 

To share your zipped Esteem backup file      

On your Esteem toolbar, go to File>Backup>Send as Attachment and select "No" when the "Backup 
Options" dialog box appears. 
 
Note: Send as Attachment function might not work if your pc does not have a default email application. If 
you encounter this challenge: please use the Create New Backup option instead. Once the backup file 
has been saved, you can manually attach it to an email using your preferred email. 
You can set your default email application by using your Windows in-build Settings application. 

 

Modes of Support 
Get our supports, list of FAQs, etc. at  
Official website: https://www.esteemsoft.com 
Official Email: support7@esteemsoft.com.my 
Official WhatsApp: +603-8076 2788  

mailto:support7@esteemsoft.com.my
https://www.esteemsoft.com/
mailto:support7@esteemsoft.com.my
https://wa.me/60380762788
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